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Funcionalidade principal

Transcricdo

Tragamos todos os caminhos e criamos todas as telas necessarias para que um novo usuario possa usar o aplicativo.
desbloquear nossa visao da tela.

Nesta etapa, criaremos a funcionalidade principal: pesquisar enderecos e exibi-los no mapa com suas respectivas rotas.

Comecaremos nosso trabalho na pagina Tela Principal , e arrastaremos o painel dindmico para a direita para
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Adicionaremos os botoes da tela principal, sdo eles o "BIZE" e "Foco na "Localizacao", presentes em nossa biblioteca

personalizada. Posicionaremos o botdo BIZE na parte inferior esquerda da tela e, logo acima, o botZo de foco.
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Se existe um foco de localizac?o, é necessario que haja um icone que aponte para o lugar exato em que o usuario se

situa no mapa. Daremos dois cliques sobre a tela e selecionaremos "Statel" do mapa.
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Dessa forma, teremos a visualizacdo do mapa inteiro. Selecionaremos "fcone Ponto de Localizaciio" e o posicionaremos
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Fecharemos a aba de painel dindmico e voltaremos a trabalhar em Tela Principal . Percebam que o icone de bicicleta
que indica a posi¢do do usudrio permanece visivel. Adicionaremos mais uma pagina.

Em "Sitemap", clicaremos no icone de criagdo de paginas e nomearemos esse novo arquivo de Tela Principal
dindmico anterior.

(registrado) , que seria a tela principal do usudrio que ja possui registro no aplicativo, e ndo veria o pop-up no painel

Iremos definir a interacdo para o botdo de localizagdo selecionando-o e indo até o "Widgets Interactions", em que
clicaremos sobre "OnClick". Em seguida, selecionaremos o item "Open Link".
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Click to add actions
¥ Links

I » Open Link I
lose Window >
» Open Link in Frame L3
Scroll to Widget (Anchor Link)
v Widgets
» Show/Hide
Set Text
Set Image
» Set Selected/Checked
Set Selected List Option
» Enable/Disable
Move
» Bring to Front/Back

E depois escolheremos a opcao "Tela Principal (registrado)" que acabamos de criar.

Configure actions

Open in  Gurrent Window -
© Link to a page in this design

Search

is AepMap
v D Carregando...
v D Servigo de Localizagio
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v D Cédigo de Verificagdo
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Definiremos a interagdo para o botdo "BIZE", responsavel justamente pela pesquisa de enderecos. Precisaremos criar

um novo painel dindmico que conterd os campos necessarios para a realizagdo de uma pesquisa.

Na biblioteca default de Widgets, selecionaremos "Dynamic Panel', e o arrastaremos para a area de edicao; ajustaremos

suas propor¢des para que ocupe toda a tela.
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Daremos um clique duplo sobre o painel dindmico recém criado e o nomearemos como "Painel Bize" - referente ao
botdo "BIZE" - e selecionaremos modificando o nome de "Statel" para "Pesquisar. No icone de + , criaremos um novo

estado que chamaremos de "Resultado da busca":

0@ Dynamic Panel State Manager

Dynamic Panel Name: | Painel Bize
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%
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O painel esta criado; daremos outro clique duplo sobre ele e selecionaremos o estado "Pesquisar", para que este possa

ser editado. No painel dindmico de pesquisa, adicionaremos um retangulo que ird ocupar toda a area da tela.
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Para este retangulo, definiremos uma cor cinza representada pelo c6digo #666666 . Para a borda, definiremos a cor
branca, mas aumentaremos sua espessura acessando a seguinte ferramenta cujo icone é formado por linhas de

diferentes pesos:

Vamos adicionar um efeito de sombra cuja opacidade terad o valor de 10 .
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Com isso, teremos uma sombra bem sutil na tela, que ficard sobreposta a tela principal da aplicac@o. Depois, criaremos

um formulario selecionando a opcdo "Text Field" na biblioteca padrido de Widgets, posicionando-o na parte superior da

tela e ajustando suas proporcdes.
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Configuraremos o "Hint Text" do campo para "Pesquisar". A fonte dese texto dica serd de tamanho 16 , em itdlico. Além

disto, adicionaremos um botdo personalizado, denominado "Botdo Pesquisar".
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Iremos eliminar a borda do formuldrio, selecionando a opcdo "Hide Border" nas propriedades de Widgets.

Widget Properties and Style 7TAx
Properties Style
Max Length
| Read Only
Disabled

Vamos definir uma interacdo para o botdo de pesquisa - iremos novamente até "Widget Interactions" e clicaremos sobre
o item "OnClick". Escolheremos a opcao "Set Panel State", marcaremos o item "Set Painel Bize", e em "Select the State"

escolheremos "Resultado da Busca". Por fim, em "Animate Out" configuraremos a opcéao "fade".
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Dessa forma, o primeiro estado do painel esta pronto. Selecionaremos todos esses elementos por meio de "Ctrl + A" e

copiaremos todo o conteddo via "Ctrl + C". Daremos um clique duplo na tela e selecionaremos o segundo estado do
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painel dinamico, isto ¢, "Resultado da busca".

Dynamic Panel Name: | Painel Bize
Panel States

+Btr @@ x

Pesguisar
ﬁmo da I::l.m(:a_l l

Cance

Teremos uma drea de edicdo limpa, e com o atalho "Ctrl + V" colaremos todo o contetido que copiamos anteriormente.

Deletaremos o botéo e o campo de pesquisa, de forma que sé reste um fundo cinza e sua borda.

% Painel Bize / Resultado da busca (Tela Principal) «  Apph
0 100 200 300

=1

Neste ponto precisamos incluir algumas opg¢des para o usuario, sendo que uma delas é fazer com que ele possa retornar

para a tela de pesquisa caso tenha digitado o endereco errado, por exemplo.

Na biblioteca default de Widgets, selecionaremos a opcéo "Label". Escreveremos a palavra "Voltar" com fonte em

tamanho 18 e na cor branca. Posicionaremos essa informac#o na parte superior da tela.
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% Painel Bize / Resultado da busca (Tela Principal) » = Apph
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Voltar

Inseriremos um retangulo e, usando o icone de mudanca de formas, escolheremos um tridngulo que aponta para a

esquerda. Reduziremos sua escala e o posicionaremos ao lado da palavra "Voltar".

Precisaremos conferir qual posicdo o campo de busca ocupava na tela. Em Tela Principal , daremos um clique duplo e

selecionaremos a opgdo "Pesquisar".

00 Dynamic Panel State Manager
Dynamic Panel Name: Painel Bize

Panel States

+ V@ w x

Pe-squisar*

Resultado'da busca

‘ concel | D

Na parte superior direita da tela, conseguimos analisar as exatas coordenadas do campo de pesquisa. No eixo X, tempos

ovalorde 70, enoeixoYovalorde 25.

] Jmnoe T

L ‘Widget Interactions a
Text Field Name

|_interactions | Not

AAA Maea  Crastalink

Portanto, iremos posicionar o icone de "Voltar" no eixo X, com o valor de 20 para o eixo Y. Essa é uma opcao clicavel
que faz o usudrio retornar a tela anterior, bastando inserir um hot spot nesta area. Na biblioteca default de Widgets,

selecionaremos a opc¢éo "Hot Spot" e o alocaremos sobre o icone.
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Para este "Hot Sopt" atribuiremos a func¢éo de "OnClick", ou seja, iremos até o painel de "Widgets Interactions" e
clicaremos sobre essa opgao. Assim, teremos novamente todas as alternativas de interagdo. Escolheremos a "Set Panel
State" e marcaremos a alternativa "Painel Bize" e, para finalizar, em "Select the state" configuraremos a opgéo

"Pesquisar".

o0 ®
Case Name Case1

Click to add actions

¥ Links
» Open Link
Close Window
» Open Link in Frame
Scroll to Widget (Anchor Link)
v Widgets
» Show/Hide
Set Text
Set Image
> Set Selected/Checked
Set Selected List Option
» Enable/Disable
Move
» Bring to Front/Back
Focus
» Expand/Collapse Tree Node

amic Panels
et Fanel Size

Add Condition
Organize actions Configure actions
v 5 Casel Select the panels to set the state
& set Painel Bize to Pesquisar e E T ——
(Dynamic Panel)

Cag ocedig ) i .
e Set Painel Bize (Dynamic Panel) state to Pesquisar

e Flact the state | Pesquisar -l

Animate In none » t 500 ms

Animate Out  none - 1 500 ms
Show panel if hidden
Push/Pull Widgets

_Cencel | (HECES

Caso o usudrio pesquise e selecione um endereco, ele obtera uma drea com os resultados de sua busca, e s2o estes

resultados que precisamos criar. Portanto, selecionaremos a opcao "Label" na biblioteca de Widgets.

Escreveremos o texto "Rua das Flores, 3185, Vila Florida, Sdo Paulo-SP", usando fonte tamanho 18 e cor branca.

Criaremos uma linha diviséria da cor branca acionando a biblioteca de Widgets e clicando sobre a opco "Horizontal

Line".
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Sitemap (8) 7 A X g Painel Bize / Resultado da busca (Tela Principal) » | AppMap Tela Principal
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Widgets (Default) T AxX
Select Library « =+ Q a

X AS

Label Paragraph Rectangle

X pr =4

Placeholder Button Shape || Horizontal Line

Lembrando que para realizarmos a edicdo da cor da linha, basta seleciona-la e ir até o painel de cores no cabecalho de

ferramentas.

Group Ungroup Front Back Align Distribute Lo

Ii' -v.'mv .l!:l'll
a Principal _

¥
g
g
s

Selecionaremos os dois itens - texto e linha - e os agruparemos em um unico elemento. Para isso, clicaremos sobre os

objetos selecionados com o botdo direito e escolheremos a opg¢ao "Group".

Criaremos cdpias do texto de endereco e da linha. Com o elemento selecionado, pressionaremos o atalho "Ctrl" ou
"Option" para os usuarios de MAC, e deslizaremos para baixo. Com isso, estamos simulando os possiveis resultados de
busca do usuadrio.

@ Painel Bize / Resultado da busca (Tela Principal) »  AppMap Tela Principal
] &7 133 200 267

=l

&7

Rua das Flores, 3185,
Vila Flérida, Sao Paulo — SP

8

Rua das Flores, 3185,

Vila Flérida, Sdo Paulo — SP
8

Rua das Flores, 3185,

Vila Flérida, Sao Paulo — SP
&

Rua das Flores, 3185,
3 Vila Flérida, Sao Paulo — SP
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Vocé pode tornar a distribuic@o dos itens mais precisa. Com todos os enderecos selecionados, iremos até o cabecalho de
ferramentas e clicaremos sobre a op¢do "Distribute Verticaly". Esse recurso fara com que os espacos entre cada item

sejam os mesmos, tornando a composicao mais harmoniosa.

L
Group Ungroup Front Back Align

S Tmo e E
by | By 5= v He 5w
x

Criaremos uma nova tela em nosso "Sitemap", ela se chamarad Tela Principal com resultado , bem como uma grande

area de hot spot que envolve todos os enderecos presentes na tela. Como estamos construindo uma simulacéo, ndo ha

distin¢do entre os resultados que o usudrio ira clicar.

Add Case... Create Link...

Siterap (9) 7 A % W Painel Bize / Resultado da busca (Tela Principal) » | AppMap | Tela
160 20

DB 8 «®Q )

0
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v D Codigo de Verificagio
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[ Tela Principal (registrado)
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Widgets (Default) ?Ax
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X . LR

Placehoider Button Shape  Horizontal Line

—
> 3 g
Dynamic Panel
| j HE==!
Masters (1) ?Aaxg
BB ®Q

Plano de fundo

Definiremos as interacdes desse grande hot spot. No painel "Widgets Interactions" clicaremos sobre "OnClick", um

percurso ja bastante conhecido por nés. Escolheremos a opcao "Open link" e depois assinalaremos o item "Tela

Principal com Resultado".
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LK

Case Editor (OnClick)

Case Name Case

Click to add actions
¥_ Links

» Open Link o
ose Window

»

Open Link in Frame
Scroll to Widget (Anchor Link)

¥ Widgets

»

Show/Hide

Set Text

Set Image

Set Selected/Checked

Set Selected List Option
Enable/Disable

Move

Bring to Front/Back

Focus

Expand/Collapse Tree Node

¥ Dynamic Panels

Set Panel State
Set Panel Size

¥ Variables

Set Variable Value

Organize actions
v & Case1
; Open Tela principal com resultado in

Add Condition
Configure actions

Open in  Current Window -
© Link to a page in this design
Search

&5 AppMap
v D Carregando...
v D Servigo de Localizagdo
¥ [} Termos de Uso
¥ [ Cadastro do Telefone
v D Cédigo de Verificagdo
[ Tela Principal
Tela Principal {registrado)
a prin com re

Link to an external url or file

Hyperlink Tela principal com resultado.htmi

Reload current page (variable changes are applied)
Back to previous page (variable changes are not

applied)
_Gancs_

Voltaremos a trabalhar em Tela Principal : empurraremos o painel dindmico de busca levemente para a esquerda, de

forma que um pequeno pedaco no mapa fique visivel a direita. De forma mais precisa, o painel dindmico estd localizado

em eixo X com -35 .

100

TR

Esse leve deslocamento que torna o mapa visivel sugere ao usudrio que este painel pode ser deslizado. Nos falta apenas

a implementacdo deste recuso. Com o painel selecionado, iremos até a area "Widgets Interactions" e selecionaremos a

opcao "OnSwipeLeft".
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[ Widget Interactions and Notes
Dynamic Panel Name
Painel Bize

Notes PFO) |
Add Case... Create Link...
K OnClick
'i OnPanelStateChange
"R OnDragStart
"} Ondrag
OnDragDrop

"} OnLoad

Mare Events

7T Ax

Na nova caixa de didlogo selecionaremos "Show/Hide", assinalaremos a "Painel Bize" e, para a opcdo "Animate",

configuraremos "slide left".

» Open Link in Frame
Scroll to Widget (Anchor Link)

v '
» Show/Hide o

Set Image
» Set Selected/Checked e

Set Selected List Option
» Enable/Disable

Move
» Bring to Front/Back

Focus
» Expand/Collapse Tree Node
Dynamic Panels

Set Panel State

Set Panel Size
Variables

Set Variable Value
Repeaters
Miscellaneous

Wait
Other e

eoe Case Editor (OnSwipeL of)
Case Name Case 1 Add Condition
Click to add actions Organize actions Configure actions
¥ Links v 5 Casel Select the widgets to hide/show
» Open Link ; Hide Painel Bize slide left 500 ms Search 1 Hide Unn
Close Window
This Widget

> {Dynamic Panel)

» || Cadastro do perfil do usudrio (Dynamic Panel)

(image)

(Snape)
F Painel Bize (Dynamic Panel) Hide siide lef§500 ms
TSnape]

(Text Fieid)
pesquisar (Image)
(Snape)
(Snape)
(Shape)
(Hot Spot)
(Snape)
(Horizontal Line)
(Shape)
(Horizontal Line)
(Snape)

Visibility Show () Hide Toggle

| Pull Widgets

Selecionaremos todo o painel dindmico de busca e o arrastaremos para o lado esquerdo, de forma que possamos

visualizar o mapa e o botdo Bize, a quem atribuiremos uma fungio.
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Pesquisar

Com o bot#o selecionado, clicaremos sobre "OnClick" na area de interacdo dos widgets, e em "Show/Hide", e

assinalaremos a opg¢ao "Painel Bize". Para finalizar, "Animate" sera configurado como "slide right".

ece

Case Name Case

Click to add actions Organize actions Configure actions
¥ Links v ;E Caset Select the widgets to hide/show
» Open Link & Show Painel Bize slide right 500 ms e (] Hide Unnamed
Close Window T T [
» Open Link in Frame | (image)
Scroll to Widget (Anchor Link) (Shape)
e F u Painel Bize (Dynamic Panel) Shcunideri#ﬂ!-lll)a
TSnape)
| (Text Field)
» Set Selected/Checked pesquisar (Image)
Set Selected List Option (Shape)
» Enable/Disable (Shape)
Move (Shape)
» Bring to Front/Back | (Hot Spot)
Focus (Shape)
» Expand/Collapse Tree Node (Horizontal Line)
¥ Dynamic Panels (Shape)
Set Panel State (Horizontal Line)
Set Panel Size (Snape)
¥ Variables (Horizontal Ling)
Set Variable Value (Shape)
» Repeaters
¥  Miscellanecus Visibility ) Show Hide Toggle
Wait
O e |An1mats slide right - Jt: 500 ms
More Options none -
Cancel

Retornaremos ao painel dindmico de pesquisa para sua localizacdo inicial, com o eixo X igual a -35 . Definiremos este

painel como "Hidden", ou seja, ele ndo estard visivel a ndo ser que o usudrio pressione o botdo Bize, e acione o

mecanismo de busca.
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| .| Dynamic Panel Name
{| Painel Bize

Add Case... Edit Case... Dalete Case
" OnClick

B AnDanai@ratahanma
Iremos alocar o painel de criaco de perfil de forma que ele sobreponha todos os outros elementos. Clicamos sobre ele

com o botdo direito e escolheremos as opcdes "Order > Bring to front".

0 00

8 Apphap | TetaPrincipal [
200 00

Crie o seu perfil
Conecte-se a outros ciclistas
que também estio no Bize!

Ao testarmos nosso aplicativo, veremos que tudo ocorre como o esperado. Nos falta, no entanto, definir a Tela
Principal com resultado . Primeiramente, copiaremos todos os contetidos de Tela Principal , e entfio abriremos a

pégina Tela Principal (registrado) .

[#] Tela Principal (registrado) « | AppMap | Tela Principal
o 00 20 300

Crie o seu perfil
Conecte-se a outros ciclistas
que também estéo no Bize!
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Percebam que hé o painel dindmico de cadastro, que sera deletado para que a nossa area de edicdo exiba o icone de
bicicleta no mapa, bem como o botdo de localizacdo e suas notificacdes:

AppMap Tela Principal
200 300
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2
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2
> 4 2
2
0 $
8 d b
) -
4 »

(registrado) .

Iremos até a pagina Tela principal com resultado e colocaremos o contetido copiado previamente. Deletaremos o
painel dinamico oculto, deixando nossa area de edigdo com Tela principal com resultado e Tela Principal

assinalaremos "Tela Principal com resultado".

O botéo de localizagéo - na parte inferior esquerda da tela - deverd continuar visivel, no entanto devemos atualizar sua
interacdo. Com o botdo selecionado, iremos até "OnCick" em "Widget Interactions", e na area "Configure actions"

Deletaremos o boto Bize, de forma que fiquemos apenas com o botdo de localizacdo na tela. Copiaremos o botZo de
se encontra em seu centro.

localizacdo e colocaremos o resultado logo abaixo. S6 sera copiado o circulo que compde o botdo, e ndo o tridngulo que

®

o

3

8, a 2

2

< 3

%

o UOB H
gn

Dentro desse circulo nds digitaremos um "X", usando fonte de tamanho 29 em negrito, e de cor vermelha. Esse novo
botfo sera responsavel pelo cancelamento da viagem em curso.

>

L=

2

g, a 2

g

> 4 3

3

o uOn 5
ge X o

o---o0--0
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Iremos atribuir o valor de cancelamento para esse novo botdo, e mais uma vez iremos até o botéo "Open" em "Widgets
Interactions". Na nova caixa de didlogo, selecionaremos "Tela Principal (registrado)".

Nossa proxima etapa envolve representar graficamente no mapa o caminho a ser percorrido pelo usuario. Daremos um

clique duplo sobre a tela e selecionaremos "Statel", o que fard com que o tamanho real do mapa seja exibido.

alaranjada para a linha e ajustaremos sua espessura.

Com base na representacio da localizacdo atual do usudrio, iremos comecar a tracejar a marca grafica de rota. Na
biblioteca padrio de Widgets, selecionaremos a "Horizontal Line". No painel de ferramentas, selecionaremos uma cor

Comecaremos a desenhar o percurso pelas ruas do mapa, lembrando que a tecla "Ctrl" ou "Option" nos auxilia
duplicando retas, as quais vamos rotacionando de acordo com a necessidade.

2

-
?&;

localizacao.

Dessa forma, teremos a emulacdo de uma rota a ser tragada pelo usuario de acordo com seu destino e ponto inicial de

Tela Principal (reg
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Ao testarmos o protétipo no browser veremos que a passagem e a interacdo entre botdes e telas ocorrem normalmente.
A préxima etapa consiste em testarmos o Bize em nosso smartphone.
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